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Microsystems World CNC, LLC makes no warranties either ex-
pressed or implied, including any implied warranties of fitness for a
specific purpose, for this software. This package is provided solely
on an “as is” basis. All risk involved in the use of this software is the
responsibility of the purchaser.

Program errors, improper software configuration, hardware failures,
or other problems can result in damage to the machinery being
controlled. Failure of limit switches, cabling, or port components can
result in machine movement past limits, potentially damaging the
machine and endangering operators. It is imperative that a separate
Emergency Stop system be in place, which bypasses all computer
control. Software features to abort motion from the keyboard and
limit switch inputs are provided as conveniences only, and must not
be relied upon to stop motion in an emergency.

Microsystems World CNC, LLC disclaims all liability for any and all

damages, including incidental and consequential damages in con-

nection with use of this software. The sole and exclusive liability of
Microsystems World CNC, LLC will be limited to the purchase price
of this software package.

If you do not understand and agree with these disclaimers, please do
not use this product. Return all materials to the place of purchase for
a full refund.
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WIinCNC Controller Installation
Installation

CAUTION: DO NOT USE THIS SOFTWARE ON A COMPUTER
CONNECTED TO A MACHINE UNLESS THERE IS AN EMERGEN-
CY STOP READILY AVAILABLE WHICH WILL INDEPENDENTLY
STOP THE MACHINE.

Software features to abort moves from the keyboard and limit switch
inputs can NOT be relied upon in emergency situations and are pro-
vided as conveniences only!

Requirements

WInCNC uses PCI bus interrupts to achieve precise step pulse ac-
curacy. When used with the right PC build WinCNC can output 75khz
on all six step outputs with microsecond accuracy and 100% reli-
ability. Fast PCI bus interrupt response is necessary to get the best
performance from your CNC machine.

*CPU: A Pentium 4 CPU is the minimum requirement, with a Core2
or i-3/5/7 CPU recommended. For AMD systems a socket FM2+
CPU is required.

*RAM: 2GB of RAM is the minimum requirement, with 4GB of RAM
recommended.

eHard Drive: Very little hard drive space is necessary. A standard
WInCNC installation requires less than 100MB.

*OS: WInCNC supports Windows XP, Vista, 7, and 8. Both the 32
and 64 bit versions of Windows are supported.

eCase: A MicroATX Mini or larger case is required. Hardware dimen-
sions should be verified for a MinilTX case.

eIntel Motherboard Chipset: P4-800 series, 900 series, and ICH
series chipsets. Core2-945 series, P45, and G41 (recommended).
1156-All. 1155-Q65, Q67, Q75, Q77, B65, and B75 (recommended).
*AMD Motherboard Chipset: A45, A55, A58, A68H, A75, A85X,
A88X, A55E, A77E, and A78 (recommended).

*Motherboard Expansion: One PCI expansion slot is required.
Hardware dimensions are slightly larger than a single slot. Additional
room below the PCI slot is required in some cases.

*USB Port: An enabled USB port is required.
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WIinCNC Controller

Hardware Installation and Configuration of the PCI-7200 Card

**|t is highly recommended that you use an anti-static wrist strap
before handling any components.

Below are the components for the PCI-7200 installation. These
include a PCI-7200 card, a Daughter Board, and a ribbon cable con-
nector.

WInCNC Users Guide Page 4



WIinCNC Controller Installation

Below is the PCI-7200 card on the left, the Daughter Board on the
right and the spacer/screw assembly. Note the matching holes in
the corners of the Daughter Board and the PCI-7200 card. There is
another set in the other end of the cards as well, just beyond the rib-
bon cable connector.

Note: The next step may already have been done prior to shipping.

Insert the Daughter Board onto the 40-pin connector of the PCI-7200
card. Attach the two cards with the included spacers and screws.
This will ensure constant connection between the two boards.
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WIinCNC Controller Installation

Power down and unplug the PC from any power.

Connect the ribbon cable (or cables) into the matching header (or
headers) on the Daughter Board. Now, install the PCI-7200, with

the Daughter Board connected, into an available PCI slot on the PC
motherboard. Next, install the DB37 or DB25 ribbon cable connec-
tors into empty slots on the PC rear panel. Screw or fasten the PCI-
7200 and DB connectors into place. Now you can connect the 4-pin
PC power supply (floppy drive style) cable to the Daughter Board.
This direct power supply connection is optional and may not be avail-
able in your PC.
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WIinCNC Controller Installation

Once installed there will be a black DB37 connector (CN1) available
at the rear of the PC, and either one blue DB37 connector (CN2), or
in some cases one or two blue DB25 connectors. The number and
size of connectors available depends on the Daughter Board type
that is required for your CNC machine.

VERY IMPORTANT! If you are unsure about where each cable from
your CNC machine should connect at the back of your PC the con-
tact technical support to verify the correct cable locations. Damage
to the PCI-7200 or Daughter Board is possible if cables are con-
nected incorrectly.

After installing your PCI-7200 card and the extra connector, boot up
your computer for driver and software installation.

*Note: When your computer boots up, you may get a hardware
installation wizard. Close it. You will be installing the driver after the
software is installed.
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WIinCNC Controller Installation

Install software

Insert the WinCNC Controller CD-ROM into the CD-ROM drive. If
the installation does not automatically start, you will need to manu-
ally run the “Setup.exe” file on the disk. To do this, click “START”,
then “My Computer”, then right click on the ‘D:, E:, or F:” drive that is
labeled ‘WinCNC.”. You should get a menu that pops up.

On that menu, click “Explore”. Once the files on the CD are visible,
double click the “Setup.exe” file. Follow the prompts of the installa-
tion wizard. The install routine will create the specified directory if it
does not exist and copy the necessary files into it. If there is a previ-
ous installation of WinCNC controller the files will be overwritten.

Driver Installation for PCI-7200 Card:

*Normally, driver installation is done automatically by the
installation CD.

For software version 2.4.xx:

A driver is required for the PCI-7200 card. The driver is included in
the PCI-7200 folder on the root directory of the WinCNC installation
disk for user convenience. If the installation disk isn't available, the
driver can be downloaded from the Microsystems World CNC web
site. After connecting to the internet, go to www.wincnc.net and click
on the “Resources” link at the top left of the page, then click “Down-
loads”. Next, find the “CNC Windows/” link and click that, then click
“Device Manager”, click “2.4”, then click “PC17200”, and finally click
“PCI7200.exe”. Next click “Save” and browse to your desktop, and
then click “Save” again. Once the download is complete, click “Run”,
and then “Run” again. Make sure at this point, that you “browse” to
the WinCNC folder on your C:\ drive before clicking “Unzip”.

Go into the PCI7200 folder inside of the WinCNC folder and find
“uninstdrvr.bat”. Run that file, and be careful not to close it before it
is done. Watch for prompts asking you to press a key to continue.
After that is done, run “instdrvr.bat”. Same thing.... Either or both of
these may take longer than you think, and may pause and not do
anything long enough for you to think it might not be working correct-
ly. Sometimes those two files run fairly quickly, but there have been
instances when they take a couple of minutes to complete.
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WIinCNC Controller Installation

After running both files, reboot your computer and try opening
WInCNC.

Run the program by double clicking on the WinCNC icon on your
Windows desktop.
For software version 2.5.xx or 2.6.xx:

In the WINnCNC folder, there is a file named “driverinstaller.exe”. This
should be the only file you need to run in order to install the PCI card
drivers. Double click on this file to run the driver installer program
which will automatically detect the operating system and install the
correct device driver (32 bit or 64 bit).  After the program is finished,
reboot your PC, and the driver should be installed correctly.

To verify the correct installation of the device driver, for all 2.4,
2.5, and 2.6 versions, do the following:

Click “Start”, right-click on “My Computer”, click “Properties”. Then
find the “Hardware” tab, click it, then click the “Device Manager” but-
ton. In the Device Manager list, there should be two components as
shown and circled below.

'y Computer
o Disk drives
] § Display adapters
% D¥DJCD-ROM drives
1-i=) Floppy disk controllers
+- t4 Floppy disk drives
+-[&9 Human Interface Devices
[+-=3 IDE ATAIATAPI controllers
[+ \,‘g IEEE 1234.4 compatible printers
+-i.a IEEE 1284.4 devices
* Imaging devices
[+-<» Keyboards
@+~ ") Mice and other pointing devices

[ ] ] [ [#]
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WIinCNC Controller Program Operation

Overview

WInCNC Controller has advanced features to provide the smoothest
possible cuts. G-Code input is constantly buffered to ‘vector match’
moves. This means your machine only slows down when it needs
to and then only as much as needed to stay within the acceleration
parameters programmed. WinCNC Controller also does S-Curve
acceleration through arcs and matches arc tangential velocities with
straight moves to provide smooth arc moves. The result of these
features is simply smoother cuts and less need for finishing opera-
tions. WIinCNC Controller has a highly customizable, user-friendly
interface that lets you take control of your machine, providing fea-
tures previously only found on custom industrial controllers.

Any stepper, micro-stepper, or servo system with step and direction
inputs can be interfaced using the included PCI card and micropro-
cessor daughter board, or one of several available PCI I/O expan-
sion cards. In addition to axis motion, up to 128 auxiliary outputs
and 128 separate inputs may be defined. The intuitive user interface
is easy to learn and convenient to use. All the features you need and
expect are readily accessible via industry standard G-Codes. Simple
keystrokes provide the ability to start, pause, restart, jog, and rapid
transit any axis without navigating multiple screens and windows.
Programs may be run from any line as needed. The programmed
feed rates may be adjusted from 1% to 200% without stopping ma-
chine motion.

Run the program by double clicking the WinCNC icon on your Win-
dows desktop. Program options may be selected from the pull down
menu using the mouse, ALT+ menu key, or function keys while the
machine is stopped. Files can either be typed into the command line
or you can use the File menu’s open option to bring the file name to
the command line. Using the open command does not automatically
run the file, it just brings the name to the command line.
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WinCNC Controller Program Operation

Screen Display

The following section contains a sample of the WinCNC software
display. Common components are labeled to provide clarity.
NOTE : This screen may differ from your screen layout, as it is
highly customizable and may have been altered by the CNC ma-
chine manufacturer.
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Screen Display Component Breakdown

Menu Bar

The Menu Bar contains many of the main features of the WinCNC
software. It is broken down into several generalized sections, as
shown below. The menu bar selections are described in the follow-
ing pages. If a menu option has a shortcut key, the shortcut key
combination is listed in parenthesis () after the name of the menu
option.
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WIinCNC Controller Program Operation

Eile Configuration Settings Wiew DOptions Units Transit Jog Help
File Menu

Open (CTRL+O) - Opens a file.

Edit (CTRL+E) - Opens the editor. If a filename is in the command
line, the editor opens that file.

Simulate (CTRL+S) - Simulates a file running to check for errors and
estimate run time.

View (CTRL+V) - Views a file in the viewer window.
Restart (CTRL+R) - Opens the file restart dialog box to restart a file.

History (TAB) - Opens a dialog box with a list of recently ran files
and/or commands. User can select one and click OK to execute it.
Caution: The file/command will execute as soon as you click OK.

List - Opens a dialog box that allows the user to load and save a list
of G-Code files or commands. User can select a file/command from
the list to run. When file/command is completed, the list box will re-
appeatr, ready to execute the next file or command. Files/commands
that have already been executed are denoted by an asterisk (*). This
helps the user keep track of which files/commands have been run in
the list.

Create Home File (CTRL+H) - Creates a home file at the current
machine position.

Import => DXF - Allows the user to import DXF (Drawing Exchange
Format) file.

Import => HPGL - Allows the user to import HPGL (Hewlett-Packard
Graphics Language) file.

*Note: The DXF and HPGL import feature is intended for cutting
simple designs. WIinCNC does not compensate for tool diameter
when converting these files. For more complicated design, where
intelligent tool pathing is important, please use a compatible CAD/
CAM program.
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WIinCNC Controller Program Operation

Digitize => Manual - Enable/Disable the Manual Digitizing Toolbar.

Digitize => Automatic - Automatic digitizing (L802, L803).
Digitize => Frame - Skeletal Digitizing (L810). This scanning
method scans a center line or spine, and horizontal lines or ribs of
the object.

Digitize => Outline - Creates an outline trace around an object.

Digitize => Laser => Run Scan - Opens the laser digitization dialog
box to set up laser scanning parameters.

Digitize => Laser => Reprocess Data - Opens a data file from a
previous laser scan used to re-generate a 3D object with different
filtering options to improve the quality of the 3D object.

Exit - Closes WIinCNC.

Configuration Menu

D/A Calibration - Calibration Settings for D/A (Digital to Analog)
spindle speed control. This can only be used if D/A has been acti-
vated in the WinCNC Program.

Settings Menu

Positions - Opens the positions dialog box with options to view and
edit stored positions. (Ex: G53 P# to call position in G-Code)

Home Positions - Opens the positions dialog box with options to
view and edit stored home positions. (Ex: GO H# to call home pos.)

Tool Positions - Opens the tool positions dialog box with options to
view and edit stored tool positions for use with automatic tool chang-
ers. (This requires an additional software feature to be enabled)

Tool Library - Edits and views the defined tool library.

Local Coordinates - View XYZ coordinates.
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WIinCNC Controller Program Operation

View Menu

Resolution - View current resolution settings for each axis.
Acceleration - View current acceleration settings for each axis.
Limits - View current limit settings for each axis.

Inputs - Views real-time input states. Useful as an aid to check for
incorrect limit switch settings verses bad hardware/wiring.

Outputs - Views and allows changes to real-time output states.
Toolbars - Enable/Disable the main toolbar.

Toolbars=> Size - Change toolbar from small to large.
Refresh View (F5) - Refreshes the screen.

Clear Screen (CTRL+C) - Clears the message display window.
Options Menu

Soft Limits (CTRL+L) - Enable/Disable the software limits.

Keyboard (CTRL+K) - Enable/Disable the keyboard transit/jog con-
trol used to move the machine with the keyboard.

Buttons - Used to customize user buttons.

Auto Repeat - Auto populate the command line with the last com-
mand executed.

Auto Run - Enable/Disable the auto run feature.
Auto Preview - Enable/Disable the auto preview feature.

Single Step (CTRL+P) - Enable/Disable single line execution of G-
Code files.
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WIinCNC Controller Program Operation

Units Menu

Inches - Sets the unit of measure to inches.
Centimeters - Sets the unit of measure to centimeters.
Millimeters - Sets the unit of measure to millimeters.
Transit Menu

Slow (F2) - Sets the transit speed to slow.

Medium (F3) - Sets the transit speed to medium.

Fast (F4) - Sets the transit speed to fast.

Jog Menu

0.001 (F6) - Sets jog increment to 0.001 units of measure.
0.01 (F7) - Sets the jog increment to 0.01 units of measure.
0.1 (F8) - Sets the jog increment to 0.1 units of measure.

1 (F9) - Sets the jog increment to 1 unit of measure.

Custom (F10) - Allows the user to set a custom jog increment.

Help Menu

Help Topics (F1) - Displays the WinCNC Users Manual or other
Help files set up by your manufacturer.

Update Program - Opens the update utility.

About - Displays the WinCNC “About” box which contains impor-
tant information about your specific software package. The About
box displays your security key serial number, the software version
number, your user level, the maximum number of axes, the table size
limitation, and which additional features you have enabled. If you

do not have a feature enabled that you would like or need, you can
contact your software vendor for an upgrade.
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WIinCNC Controller Program Operation

Tool Bar

The tool bar is a collection of shortcut buttons that perform specific
actions. The toolbars in WinCNC are floating and can be positioned
or docked to the user’s preference. The image below shows both the
standard and manual digitizing toolbars both docked in the normal
toolbar area. The additional images show each toolbar separately
as a floating toolbar. The explanation of each button on the toolbar
is as follows. The explanations move sequentially from left to right
along the toolbar.
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Start Motion - This button will begin the command or job listed in the
command line.

Restart - Allows you to pick a job file and the line to start that file on.
This is useful if you want to skip over lines in a job file, or if you have
aborted a job and want to start back at the point you aborted from.
You can also choose to run the file in single step mode.

Single Step - When selected, this allows you to execute one line of
a G-Code file each time you hit ENTER.

Abort Motion - Aborts a command or job that is running.

Pause/Continue Motion - Pauses/Continues a command or job that
is running.

Open File - Opens a browse box that is used to open a job file.

View History - Opens the command history box, which allows a user
to execute a command used previously. When an error is found in
the WINCNC.INI file, the line containing the syntax error is displayed
here in red when WinCNC starts.

Edit - Opens the default editor specified in the WINCNC.INI file.
WInCNC uses Notepad by default. The editor can be used to open
job files, listed in the command line in the editor.

Simulate - Simulates a file to check for errors and run-time.
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WIinCNC Controller Program Operation

View - Opens a file for viewing in the viewer window.

Soft Limits - Enables/Disables Softlimit features.

Manual Digitize Buttons - The seven buttons on the manual digiti-
zation toolbar are for use only with the Manual Digitize feature, and
will only be visible after showing the manual digitize toolbar under
the View->Toolbars section of the menu bar.

Start a Manual Digitized File - Starts a manual digitized file and
enables the manual digitize mode.

Add a Rapid Move - Adds a rapid move to the manual digitized file.
Add a Feed Move - Adds a feed move to the manual digitized file.
Add an Arc Point - Used to add arcs into a manual digitized file.

Close Shape - Used to close the last move in a shape without mov-
ing the machine.

Undo - Used to undo previous moves.

Save - Allows you to save the manual digitized file in either G-Code
or DXF file format.

Command Line

WTEST. TAP

The command line is the input line for users to enter commands or
job files to be executed.
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WInCNC Controller Program Operation
Message Display Window

(53 ¥32 6715 Y9567 12,7245 -3 6553 |
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The message display window is the main output window displaying
the commands that have been executed, messages to the user, or
errors that have occurred during an operation.

Axis Window

IN G54 G43 G92 100%

<X 0.0005 2000
Y» 0.0005 2000
Z 0.000g 150
W 0.000 | 150

The axis window is the primary display for current information about
each axis on your machine. The current positions and velocities for
each axis are displayed in the text boxes. Displayed above the posi-
tion and velocity boxes are the current units of measure, any current-
ly active modes, and the current feed rate override percentage. Red
triangles to the left and right of each axis label indicate low or high
limit switch hits. Ared triangle to the left of an axis label indicates a
low limit switch hit, and to the right indicates a high limit switch hit.

A green box displayed to the right of the position box indicates a
temporary workspace (G92) setting, and a blue box indicates a tool
length measure or workspace setting. To the far right side of the axis
window is the feed rate override control slide bar.
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WIinCNC Controller Program Operation

Transit Speed Buttons
These buttons allow you to specify the transit speed of
your machine.

Fast transit is the default.

In the cncscrn.ini file, change the “default speed” field to
1, for the speed you would like to be default, all others
must stay 0.

Ex: for default medium speed, use the following:
“JogMode”, 0,5,35,25,7,1,"Med”,”,”,-1,-1,”"med.bmp”

Jog Increment Buttons

These buttons allow you to specify the increment of a jog move.

Transit/Jog Buttons
These buttons are what allow you

to initiate a manual transit or jog
movement from the console of the
computer that runs the machine.

In transit mode, holding the button
down will continuously move the
machine. In jog mode, each time a
button is pressed the machine will
move according to the jog increment that has been selected. Hold-
ing the button down in jog mode will move the machine only once.

Custom Screen Buttons Section

This section of controls is a
customizable button section that
allows the user to place shortcut
buttons to activate heavily used
commands.

Note: See Section 4 Screen Con-
figuration
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WIinCNC Controller Program Operation

Status Bar

The status bar is the label along the bottom of the WinCNC window
that looks similar to the one shown below. This bar provides the user
with the status of several features in WIinCNC. Each section in the
example below is labeled for clarity.

Elapsed Time for
Current File G00/G01
Current Mode

Line in Job Indicator
File
WTEST. TAP |Line:2 [00:09 [0 | Tool 2 [Mo Tool |GUD GSD|

Percentage of File / / /
Current File : G90/G91
Completion Tool Changer ON/OFF Mode

and current tool being Indicator
used

* Note: There are TWO tool
changer indicators
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WIinCNC Controller

Program Operation

Shortcut Keys

File Menu _Shortcuts

Open Enter (with blank command line), CTRL+O
Edit CTRL+E
Simulate CTRL+S
View CTRL+V
Create Home File CTRL+H

View Menu Shortcuts

Refresh View

F5

Clear Messages

CTRL+C

Options Menu Shortcuts

Keyboard

CTRL+K

Soft Limit

CTRL+L

Transit Menu Shortcuts

Slow F2
Medium F3
Fast F4

Jog Menu Shortcuts

.001 F6
.01 F7
1 F8
1 F9
Custom F10

Help Menu Shortcuts

Help

F1
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WIinCNC Controller Program Operation

Shortcut Keys continued

Tool Bar Shortcuts

ESC Aborts the current file or command
SPACE Pauses a file or command

ENTER Starts/restarts a file or command
TAB Opens the command history box
CTRL+R Opens the restart file box

Feed Rate Override Shortcuts

INSERT Increases override rate
DELETE Decreases override rate
CTRL+either Resets feed rate to 100%. No over-

ride settings

Manual Digitize Shortcuts
After opening the Manual Digitize toolbar and clicking the green

start button, the following shortcut key combinations become active
for adding moves to the digitized file.

Add Rapid Move CTRL+J
Add Feed Move CTRL+F
Add Arc Midpoint/Endpoint | CTRL+A
Undo Last Move CTRL+U
Close Current Shape CTRL+D
Save CTRL+W

Spindle Speed and Laser Power Shortcuts

Spindle Speed Alone or + - (plus and minus)
Laser Power Alone

Spindle Speed and Laser Laser Power uses + -
Power Together Spindle Speed uses Shift + -

CTRL+(Function Key) | See “ctrlf#=" in configuration settings
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WIinCNC Controller Program Operation

Limit Switches

The default channel settings will normally provide proper interfacing
with the machine’s limit switches. Before attempting to move the
machine, verify that all limit switches are functioning properly. Limit
switch status is displayed in the position window using a red triangu-
lar indicator to the left or right of the axis label.

IN_G54 100% IN G54 100%

) 0.000 | 200 l 0.000 | 200
0.000 | 200 Y»[) 0.000/ 200 ’

J

|

Z 0.000 | 50 Z 0.000 50
W | 0000 | 50 W | 0.000 50

The indicator to the left of the axis label shows low limit status for
that axis. The indicator to the right of the label shows high limit
status. If the indicator is present then the limit switch is closed,
otherwise it is open. The lim_mode setting is used to control how
WInCNC responds to limit switch triggers.

First toggle your limit switches by hand. Verify that the appropriate
limit display toggles. If it does not toggle then you need to ad-

just WINCNC.INI. See the WINCNC.INI reference sections of the
manual if the default settings are incorrect for your machine.

It is recommended that you verify limit switch operation at the begin-
ning of each session. Do not attempt movement until the limit switch
displays toggle correctly. Once the limits are working try a small
move. If nothing moves, the wrong axis moves, or movement is in
the wrong direction then adjust WINCNC.INI.

Perhaps the easiest way to do preliminary testing of movement is
with the Jog mode. Select “Jog .1”, and select the KEYBOARD op-
tion under the OPTIONS menu. If you are using the default jog key
configuration, use the LEFT and RIGHT arrow keys to move X, the
UP and DOWN arrows to move Y, the PAGEUP and PAGEDOWN
keys to move Z, and the HOME and END keys to move W. Other-
wise use the buttons that are defined for your system.
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Homing the Machine
When WInCNC Controller is started, the display is set to the last

known position. If the machine has been moved manually or has
drifted while powered down, this position will not be accurate. The
G28 command must be used to home the machine. G28 homes
your machine in the order specified in the WINCNC.INI file on the
“g28move="lines. The first listed homes first. Normally the vertical
axes will home first, then horizontal axes would home next. Vertical
axes usually home to high limit switches. Horizontal axes will home
to either the low or high limit switches as set up by your machine
manufacturer. After an axis touches off its homing limit switch, it
move off the distance specified in the WINCNC.INI file and set to
zero. This position is Machine Zero for that axis.

It is important to use G28 to set Machine Zero since many WinCNC
features are calculated from this position. Soft Limits and Bound-
aries cannot be used if Machine Zero is not properly set. G28 will
search for the limits at a slow feed rate set in the WINCNC.INI file.
The “lim_step=" setting in WINCNC.INI can help minimize the impact
to the machine when stopping at the limit switches.

G28 can also be used to home only specified axes. (l.e. G28Z
homes only the Z axis).

Normal machine operation using WinCNC Controller would be:
Start WinCNC.
Enter G28. Push ENTER. (Machine Goes Home)
Enter part program to cut. Push ENTER. (Job file runs)

NOTE: Most machine manufacturers have a button on the screen
that handles homing the machine for you. It might be named “Home”,
“Seek Home”, “Initialize”, or something similar, but clicking it will run
the G28.

Feed Rate Override

WInCNC accepts feed overrides to increase/decrease the feed rate.
The feed rate can be adjusted from 1% to 200% of the programmed
rate. The override rate cannot be set higher than the max velocity
or GO rate for a given axis. Use the Insert key to increase and the
Delete key to decrease the programmed feed rate, holding CTRL
and pressing either Insert or Delete will result in the feed rate being
reset to the programmed value. There is also a slider bar to the right
of the feed rate screen display that can be used to initiate a feed rate
override. The override feed rates will be displayed in place of the
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programmed feed rates in the display. The feed rate will change col-
ors to depict that an override is in use. If the override rate is higher
than the programmed rate the color of the feed rate display will be
red, if it is lower than the programmed feed rate it will be blue.

Coordinate System

The Machine Zero (MZ) set by homing the machine becomes the
anchor point for all positions specified in subsequent G-Code com-
mands. This is also considered absolute zero, not taking into ac-
count any temporary homes (G92's) or tool measures.

Local Zeros (LZ) are set using the G92, G92.1 and G92.2 com-
mands.

The position display box displays the current axis coordinates and
the axis coordinate modes. The axis coordinate mode is displayed to
the right of the axis position.

A green box indicates that the axis has a Local Zero applied. (G92,
or temporary home).

A blue box on a horizontal axis indicates that a workspace other
than G54 is in effect. (G55, G56, G57, G58, G59: ex: using W axis
instead of Z).

A blue box on a vertical axis indicates that tool length measure is in
effect.

The coordinate modes show how the axis values in a given G-Code
command will be interpreted.

MZ Coordinates - values are relative to MZ. (Or absolute zero)

G92 Coordinates - values are relative to LZ specified by G92
(Ex: enter the command G1 X10 Y10, then enter. Next type
G92X0YO0, then enter. X & Y will now show as X0, YO0)

G55, G56, G57, G58, G59 Coordinates for horizontal axes - horizon-
tal axes values are offset for vertical axes heads.

G43 Coordinates for vertical axes - vertical axes values are offset for
M37 tool measure values.

G92 and G55, G56, G57, G58, G59, G43 - values are offset for both.
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G91 Mode

G91 mode is called relative or incremental mode. In G91 mode val-
ues specify distances. For instance if the X position is currently 20
and GO X8 is specified the machine would move +8 units of measure
in X to X28.

A G-Code program written in G91 mode may be run from any posi-
tion. Since the moves are relative, the starting position does not
matter. The program will run properly from any starting position.
However, to get the proper results, the machine must be set to the
proper position in relation to the workpiece before the piece is run.

The axis coordinate status does not have any effect on how the pro-
gram runs. It does however affect the coordinate display while the
program runs.

G90 Mode

G90 mode is called absolute mode. In G90 mode values specify
positions. If the X position is 20 and GO X8 is specified the machine
would move -12 units of measure in X to X8.

In GO0 mode the situation is different. The initial of the machine
position will not affect where the part runs since the first move will go
to the absolute position specified on the table. Instead of setting the
machine position properly before running a G90 program.

The G92 commands are used to change the coordinate system so
that any position may be temporarily made to be Local Zero (LZ).

Most G90 programs are written relative to a starting position of X0Y0
with ZOWO being either the bottom or top of the workpiece. All that is
then necessary to run the program is to insure that the current LZ is
set to match the program before running. There are several ways to
do this.

The machine may be positioned to the proper position and the G92
command used to set the proper coordinates for running.

Example: The workpiece is fixtured at X20Y20, is 1" thick and Z0 in
the part file refers to the top of the workpiece.
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G90 Commands in G90 Mode
G92 Turn off any current G92s
G0z2 Set Z 2" above the table and 1" above the workpiece

G0X20Y20 | Go to corner of workpiece
G92X0Y0Z1 | Set this position to be 1” above LZ

The Axis Window shows:
IN G54 G92 100%
0.0008| 2000 || |
0.0005 2000

1.0008 150
0.000 150

SN <X

Alternately LZ may be set by shifting MZ the desired amount using
G92.1. Using G92.1 it is not necessary to move to the workpiece
first.

Example

G90 Commands in G90 mode
(G92.1 X20Y20Z1 Move LZ 20" in XY and 1” above the table

The coordinate display shows the current position relative to the
workpiece.

When writing a G-Code program there must always be a starting
point. Typically it would be the lower left corner (in XY) of the piece
to be machined and either the upper or lower surface of the work-
piece or a position a known distance above the workpiece (ZW). In a
G91 mode program this point does not need to be given a coordinate
value.ln G90 mode this point is assigned a coordinate value (usually
0,0,0) and all positions are specified relative to this starting point.

When running the program the machine is positioned to this start-
ing point and G92 is used to set position to the start position for the
program. Alternately G92.1 may be used to shift MZ.
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Workspace
The G54/G55/G56/G57/G58/G59 functions are used to allow for

easy switching between workspace coordinates. Each G54/G55/
G56/G57/G58/G59 line you wish to use must be specified in the
WINCNC.INI file.

WINCNC.INI Setup: For descriptions see the Systems Configuration
Section of the manual.
G54=X# Y# T# A# R# O#

After configuring the G54/G55/G56/G57/G58/G59, the G54/G55/
G56/G57/G58/G59 commands can be used to switch workspace
coordinates, or for rotating a rotational axis.

If using the type 0 G54/G55/G56/G57/G58/G59 for switching vertical
heads just use the G54/G55/G56/G57 commands alone to switch
workspace coordinates.

If using the type 3 G54/G55/G56/G57 for rotational axis command
Gb4/G55/G56/G57/G58/G59 X# Y#, where X and Y are the positions
to rotate towards.

Head Swap
L12 provides a means of cutting with a head not specified within a

program and of using multiple heads simultaneously.

Example:

L12WZ moves Z whenever W is specified and moves W when Z is
specified.

L127ZZ moves Z and W together whenever Z is specified.

L12 alone or L12ZW sets normal operation.
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Tool Length Offset
M37 is used to measure tool length and set ZWUV workspace.

By using M37 it is not necessary to measure tool length for every
workpiece thickness change. Using M37 in combination with Soft
Limits and Boundaries also provides a means of protecting the table
from being routed accidentally. After M37 is set G28 will set the ZW
to the actual position of the tool tip above the table.

Example: (without automatic tool changer)
Move the Z head tool tip to the table.
Command M37 Z0.

M37 turns on G43 mode, indicating that tool length offsets are active.
Tool length offsets can be disabled using G49 and re-enabled with
G43 without re-measuring.

Soft Limit / Boundaries

Soft Limits and Boundaries are used to keep programs and com-
mand from moving into the limit switches. Values must be set in
WINCNC.INI before using.

Soft Limits check absolute position command against the limit
switch positions. If a position is commanded that would result in a
limit switch being hit, a limit error will be displayed and the move will
not be run.

lolim=X# Y# Distance from MZ (machine zero) to XY low
limit switches less .1”

hilim=X# Y# Z# W# | Distance from MZ (machine zero) to XYZW
high limit switches less .1”

ZW low limits normally are not specified since desired positions vary
with tool length.
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Boundaries check workspace positions. In G54 mode the Z head
will not be allowed to leave the table. In G55 mode the Z head might
move off the table but the W head will be kept on the table.

lobound=X# Y# z# W# | Distance from MZ to XY table edge and
top

hibound=X# Y# Distance from MZ to XY table edge

ZW high boundaries normally are not specified since desired posi-
tions very with tool length.

ZW low boundary checking is available if M37 is used. Use M37 to
set ZOWO to the tabletop. The ZW hi limits and low boundaries are
then both set to 0. This allows movement between the limits and the
table.

Limits and Boundaries may be enabled or disabled in the Settings
Menu and in WINCNC.INI using softlim=t0 or t1. TO will disable them,
t1 will enable them. Soft limits and boundaries are linked so this set-
ting controls both.

Repeat Command
The command or file name history may be viewed by pushing the

TAB key. To repeat a command from the history list select the de-
sired command or file name using the mouse, and then click OK.

Simulate

WInCNC supports the simulation of files to check for errors, estimate
runtime, and check min/max positions. To use the simulate func-
tion of WINCNC make sure the file name is typed into the command
line and instead of running the file, you will use the simulate call to
simulate the file. This is done by using either the Simulate command
found under the File menu, by pressing CTRL+S, or by pressing the
simulate button on the toolbar. Once you initiate the simulate fea-
ture, the software will display a screen showing the specifics of the
file simulated which includes the starting (x,y) positions, the ending
(x,y) positions, the min and max (x,y) positions, the number of lines
ran in the file, and the total time it will take to run the file.

NOTICE: The time function in the simulation feature does not take
into account smoothing. If you have smoothing set up on your ma-
chine, the time it takes for the file to run should be less than what is
displayed in the simulation data.
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Viewer

WINCNC contains a built in viewer window that will allow you to
display the output of G-Code files before the job is actually ran.

The viewer can also display a G-Code file line by line as it is run by
WINnCNC. When the file is displayed in the viewer you can distin-
guish GO moves from G1 moves by the color of the line. By default,
GO0 moves are shown as a black dashed line. G1 moves are dis-
played as a solid blue line. See the Screen Configuration section if a
different color configuration is desired.

You can also re-center and zoom in/out of the display within the
viewer. To view a file before you run it, enter the file name into the
command line and then press CTRL+V, select View from the File
menu, or press the viewer button on the toolbar. The file will be
displayed line by line automatically when you run the file. Once the
object is loaded into the viewer the following controls can be used:

Zoom In Incrementally - click the left mouse button.

Zoom Out Incrementally - click the right mouse button.

Selected Zoom - hold down the left mouse button and drag the box
around the area to zoom in on.

Pan or Re-Center Object - hold CTRL and click either mouse button.
Reset Image - hold shift and click either mouse button.

To set up the viewer window you must include lines in both the
WINCNC.INI and the CNCSCRN.INI files.

WINCNC.INI Setup (for descriptions see the System Configuration
section of the manual)
table=X# Y# W# H# B#

CNCSCRN.INI Setup (for descriptions see the Screen Configuration
section of the manual)
“Display”, “Viewer”, 370, 150, 270, 270
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Pump Control

Wiring for the Daughter Board

Pulse Width Modulation

-Jumper Pin 1 of connector 4 (C4) on the daughter board to
Pin 2 of C4.

-Disconnect trace between Pin 2 of C4 and Pin 3 of C4.
-Jumper Pin 3 of C4 to Pin 4 of C4

-Pin 11 of CN2 is the pump control signal.

-Pin 15 of CN2 is the pump reverse signal.

Frequency Mode
-Pin 11 of CN2 is the pump control signal.
-Pin 15 of CN2 is the pump reverse signal.

WINCNC.INI Setup (for descriptions see the System Configuration
section of the manual)
pumpcont=T# L# H# A# B# |# R#

Commands (for descriptions see the Commands section of the
manual)
L55, L56, L57, L58, L59

Buttons (see also the State Buttons section in the Screen Configu-
ration section of the manual)

Pump Mode On

“StateBtn”, 280, 5, 50, 25, 4, 0, “Pump On”, “L55", *, -1, -1, *“
Pump Mode Off

“StateBtn”, 280, 35, 50, 25, 5, 0, “Pump Off", “L58", ““, -1, -1, *“
Purge Mode

“StateBtn”, 280, 65, 50, 25, 6, 0, “Purge”, “L56", “L57”", -1, -1, *“
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Manual Digitize
WINnCNC supports the ability to manually digitize a part and then

output the file as either G-Code or DXF format. The manual digitize
toolbar is started by clicking File->Digitize->Manual. The toolbar
icons are displayed and summarized in the screen display section
of the manual. The Manual Digitize feature supports the addition

of rapid moves, feed moves, and arc moves. It also has support
for undo, close shape, and save. To digitize a part manually, place
the part on the table and transit the machine to the selected starting
point and then enable the manual digitize mode.

Now that manual digitization is enabled, to add a move into your digi-
tal file, transit the machine to the desired point and then press either
the add rapid (GO) or add feed (G1) button on the toolbar depending
on the type of move needed. To add an arc, move to the beginning
of the arc and add either a rapid (GO) or feed (G1) move, then transit
to any point along the arc and press the add arc point button on the
toolbar. The first time the add arc button is pressed it is setting a
mid-point for the given arc. Once you have the midpoint selected
transit to the end of the arc and press the add arc button again. This
will complete the arc move and add it to your digital file. Continue
transiting along the part adding in the required move types.

Once you have your part completely digitized click the save button
on the toolbar. If you saved the digitized file as a G-Code formatted
file, you can then use that file with WinCNC. If you saved the file as
a DXEF file, you can import this file into any CAD/CAM package that
supports DXF file formats and make any needed adjustments.

The Manual Digitize feature of WinCNC also supports the ability to
undo any previous moves during the digitization. If at any point you
wish to go back before moving the machine or adding a move press
the undo button in the toolbar and the machine will lift the vertical
head, move back to a previous location, and lower the vertical head
back to its initial position. The location the undo button moves to
depends on the last type of move you made. If it was simply a transit
move out into the table, undo will move the machine back to the
point you started at. If undo is used after adding in a new move, the
machine will move back to the last point that was added to the file.
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Manual Digitize continued

The manual digitize feature also has support for closing shapes. The
close shape button works by adding a feed style move from the cur-
rent point to the first point. The close shape feature handles only 1
shape at a time, and any rapid moves that are added repositions the
first point of the shape to the ending point of the rapid move. If no
rapid moves are added, the starting position for the shape remains at
the initial point.

For example: Two squares that are 10"x10” with a 5” separation
along the X Axis would be digitized as follows. Start by transiting the
machine the desired starting point and enabling the manual digitize
feature. Once it is enabled, transit the machine to X10Y0 and add
a feed move. Next transit the machine to X10Y10 and add a feed
move. Next transit the machine to X0Y10 and add a feed move. At
this point, three of the four needed sides of the square have been
added. We will now use the close shape button to continue with the
example. Once the close shape button is pressed, the vertical head
will lift, the machine will move to the starting point of the shape, and
the vertical head will drop back to its previous position. Once the
machine finishes moving, transit the machine to X15Y0 and then
add a rapid move using the add rapid button in the toolbar. This will
set the current position as the starting point of the next shape. This
example would then output a file with two separate 10"x10” squares
with a 5” separation between them.
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Frame Scan Digitizing

Default Values

XY Increment 0.5

Z Increment 0.1

XY Feed rate 30

Z Feed rate 30
Bottom Offset 0

Top Offset 0

XY tolerance 0.01
Scan Width 0

Scan Length 0

Scan Center Unchecked
Center Scan Direction Negative
Slice Scan Direction Positive
Side to Scan Top

Z Height to Calibrate 0
Distance to Raise Stuck Probe 1

Scan Increment - the distance the probe will attempt to move to
reach new points. The actual amount can be less if the probe hits
something during a move.

Scan Feed rate - the speed the machine will travel between points.

Bottom Offset - distance to shift the bottom scan data. This dis-
tance can be positive or negative.

Top Offset - distance to shift the top scan data. This distance can
be positive or negative.

XY Tolerance - the allowable difference between points on the X or
Y axis when finding an edge. Example: XY Tolerance is 0.01, the

current X point is -0.4370 and the previous point was -0.4467. The
difference is less than the allowable tolerance, so the slice will end.
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Maximum Scan Dimensions - these dimensions should be set to
the maximum distance that the user wants the probe to search for
an edge. If the board will be clamped on the ends or sides, input in
the distance between the clamps for that axis. For the other horizon-
tal axis, set the size to the maximum amount that the probe should
travel assuming that it doesn’t find an edge. Always use positive
values.

Center Scan Direction - the direction that the probe should travel on
the Y axis. If set to negative, the probe will travel from high Machine
Y to low Machine Y.

Slice Scan Direction - the direction that the probe will travel on the
X axis. If set to negative, the probe will travel from high Machine X
to low Machine X.

Slice Position Boxes - the input boxes beside the checkboxes in
the slice scan group. This is the position on the Y axis where the
slice will be measured. Always use positive values, even for nega-
tive scans.

Side to Scan - the side of the board to be scanned, Top or Bottom.

NOTE: A complete frame scan will consist of a Top and a Bottom
scan. This means that the Frame Scan utility must be ran once

for each side. The values that you set in the previous scan will be
retained in their appropriate locations, so there is no need to retype
them. The utility will compile all slices after each scan.
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How to Use the Frame Scan Digitizing Feature

1. Start WInCNC. Important! Make sure to do a G28Z or an L28Z
to set the machine Z zero to a level above the highest point of the
workspace. This is necessary because the machine does a G53
(moves to machine Z zero) between slices. If you do a G53 and ma-
chine Z zero is below material height, the probe will hit the surface at
rapid speed and be forced to stop very quickly, which could result in
damage to the probe or the part.

2. Move the probe to the XY location where you want to start the
scan.

3. Do a G92XY to set this beginning point to local zero.

4. If youwant to do an L82, move the probe to the desired position.
5. Click File->Digitize->Frame to open the Frame Scan dialog box.
6. Click Browse and set the file name and path to use. The file will
always save with a .CSV file extension.

7. Set up the Scan Increments (positive numbers).

8. If a Top or Bottom offset is to be used, set it. The default is zero.
9. Check the Scan Center box if a center scan is to be performed.
10. Choose the center scan direction.

11. Choose the slice scan direction.

12. Check the box next to a slice, then enter a Y position (positive).
Repeat this for the number of slices desired.

13. After slices have been chosen and values are entered, choose
the side to scan - Top or Bottom.

14. If an L82 is to be performed, enter the new Z value for the sur-
face and press Calibrate. The probe will descend to the board and,
when it touches, will calibrate the board surface to the height set in
the box. This is very useful if you know the thickness of the board.
Just calibrate to half of the thickness for each side and the final point
cloud will center around Z zero. Example: The board is measured at
2.5” thickness. If the board is calibrated to 1.25” for each side at the
point where it was measured, the finished scan should center around
Z zero - half above zero, half below.

15. Set the height for the probe to raise if stuck. If the probe’s Z zero
is below its current position and it sticks, the probe will try to raise the
distance specified here. If the Z zero is above the current position
and the probe sticks, the probe wil